Melamine Complex Formation & Molecular Modeling Part II
by Kelly Gallagher, Department of Chemistry and Biochemistry
SUNY College at Oneonta

PURPOSE
The objectives of this experiment are:
· to observe the effect changes in pH can have on molecular solubility
· to study the formation of a hydrogen bonded complex
· to gain a molecular-level understanding of hydrogen bonding
INTRODUCTION
The tragic deaths of four Chinese infants and the sickness of another 50,000 due to melamine-contaminated formula became a worldwide scandal in the fall of 2008, following a spate of U.S. animal deaths in 2007 from contaminated pet food. These deaths have been attributed to the pH-dependent formation of an insoluble hydrogen-bonded complex between melamine and cyanuric acid in the kidneys. 
What are melamine and cyanuric acid and how do they wind up in food?
Melamine is an organic compound that contains >60% nitrogen by mass (Figure 1). This feature is significant because the most widespread method for determination of protein concentration in food is the Kjeldahl method, which determines the total amount of nitrogen in a sample. This method is used because protein is the only major component of food that contains nitrogen (fat, carbohydrates and dietary fiber contain only carbon, hydrogen, and oxygen). The average nitrogen content of protein is 16%; thus, determination of nitrogen in a food sample should provide a reliable estimate of protein content. However, because the Kjeldahl method is non-specific, any nitrogen-containing compound will be interpreted as protein. The manufacturers of the contaminated pet food and milk products intentionally added the less expensive melamine to their products to give spuriously high protein readings. Cyanuric acid is a by-product of melamine synthesis (Figure 1). Current theories suggest that the cyanuric acid found in contaminated foodstuffs originated in impure melamine samples used to enhance the "protein" content.

Figure 1- Melamine and its analogs
What happens once melamine and cyanuric acid are consumed?
Low melamine levels are relatively non-toxic and cleared by the body rather quickly. The US Food and Drug Administration has determined safe levels of melamine in food products to be 2.5 parts per million. Tainted Chinese milk products were found to contain 520 parts per million. In addition, when melamine and cyanuric acid are consumed together, the formation of melamine cyanurate crystals in the kidney leads to renal failure.
Upon consumption, melamine and cyanuric acid first experience acidic conditions in the stomach (pH≈1.5-3.5). These compounds are absorbed by the gastrointestinal tract and eventually make their way to the kidney, where the pH is much higher (~4.6-8.0). The increase in pH causes a change in the protonation state of these molecules, allowing them to form intermolecular hydrogen bonds. The melamine-cyanurate complex (Figure 2) is very insoluble and precipitates in the kidneys to form nephrotoxic crystals, or large kidney stones.
+

Figure 2- Below pH 4, melamine and cyanuric acid are fully protonated (left). Above pH 4, the melamine is deprotonated and the cyanuric acid assumes the structure shown (middle); in this state, the two compounds form an insoluble network (right). 
What is a hydrogen bond?
Hydrogen bonds result from the attraction between negative and positive charges. When a hydrogen atom is covalently bonded to a more electronegative atom (F, O, or N), the bond is polar. That is, the electrons shared by the two atoms are not shared equally; the electrons are drawn closer to the more electronegative atom and spend less time around the hydrogen. This leaves the hydrogen end of the bond with a partial positive charge (because of the lack of electrons around the hydrogen nucleus, given the symbol +) and the other end of the bond with a partial negative charge (-, see Figure 3). A hydrogen atom involved in a polar bond will be attracted to the negatively charged lone pair(s) on another nitrogen or oxygen atom.
[image: ]
Figure 3- Hydrogen bonding between two water molecules
This strong attraction between a hydrogen with a partial positive charge and an atom with a partial negative charge is called a hydrogen bond. It is not as strong as a covalent bond and should not be confused with an ionic bond, which is a bond between two atoms with full charges, not just partial charges. The unique properties of water are due to the ability of a water molecule to form hydrogen bonds to other water molecules.

The experiment
In this experiment, you will first examine the properties of melamine, cyanuric acid, and a mixture of the two chemicals as function of solution pH. Then, you will perform a series of calculations in which you examine the differences in the distribution of electric charges in the low pH and high pH forms of cyanuric acid and melamine.




PROCEDURE PART I- EXPERIMENTAL OBSERVATION OF THE HYDROGEN BONDED COMPLEX RESPONSIBLE FOR MELAMINE-ASSOCIATED FOOD POISONING
IMPORTANT NOTES:
· To determine the pH of the solution, take a small (~1 in.) piece of pH paper and dip it into the solution. Match the color of the paper to the scale on the pH paper's container. Note that the even numbers of the scale are on one side of the container and the odd numbers are on the other. The full scale looks like this:
[image: pH_scale]
· Wear gloves when doing this lab. All solutions may be washed down the drain; rinse glassware with water.
Melamine and Cyanuric acid alone
1. Add 25mL of the 0.001M melamine solution to a 100mL beaker.  Add a small magnetic stir bar to the 100mL beaker and use a stir plate.
2. Using the pH paper, measure the pH of the melamine solution and record the results on your data sheet.
3. Using a calibrated Beral pipet, add 0.5mL of 0.1M NaOH, stir thoroughly for 1 minute, and record the pH. Write down your observations regarding the appearance of the solution.
4. Repeat Step 3 until the pH of the solution reaches ~6-7.
5. Pour the solution down the drain and rinse the beaker and spin bar thoroughly with water.
6. Repeat Steps 1-5 using 25mL of 0.001M cyanuric acid solution.
Melamine and Cyanuric acid Mixture
1. Add 25mL of the 0.001M melamine solution to a 100mL beaker. 
2. Add 25mL of the 0.001M cyanuric acid solution to the beaker that contains the melamine. Add a small magnetic stir bar to the beaker and use a stir plate.
3. Using the pH paper, measure the pH of the mixture and record the results on your data sheet.
4. Using a calibrated Beral pipet, add 0.5mL of 0.1M NaOH, stir thoroughly for 1 minute, and record the pH. Write down your observations regarding the appearance of the solution.
5. Repeat Step 3 until the pH of the solution reaches ~3. From this point, add the 0.1M NaOH in 0.25mL amounts. Repeat until the pH reaches ~6-7, recording all observations and pH values on your data sheet.
6. Pour the solution down the drain and rinse the beaker and spin bar thoroughly with water.
PROCEDURE PART II- MOLECULAR MODELING OF MELAMINE AND CYANURIC ACID
1. Go to irene.oneonta.edu and log on to WebMO using the same username and password that you used for the first molecular modeling lab (the lab in which you examined the vibrations of greenhouse gases).
2. You will be using models of melamine and cyanuric acid that have already been built and geometry-optimized. The models are located in the folder "MELAMINE", which is visible on the left-hand side of the Job Manager screen. Click on the folder to open it. The folder should contain four jobs: Melamine_Low_pH, Melamine_High_pH, Cyanuric_Low_pH, and Cyanuric_High_pH. These files contain the geometry-optimized models of melamine and cyanuric acid in different forms.
3. Calculate the electrostatic potential map of each molecule. The calculation is set up as follows:
a. Click on the name of the model in the Melamine folder to open the model.
b. Click on the "New Job Using this Geometry" button at the bottom of the viewing window.
c. Click on the blue arrow [image: ] to begin calculation setup.
d. Select "Gaussian" as the Computational Engine.
e. In the "Job Options" window, select the following options (leave any option not listed below at the default value):
Job Name: (Name the job with your initials and a name that reminds you what the calculation is. For example, "KG Melamine Low pH MO's")
Calculation: Molecular Orbitals
Theory: Hartree-Fock
Basis Set: Routine 6-31G(d)
f. Start the calculation by clicking on the blue arrow[image: ].
4. Viewing and interpreting your results
a. Click on the job of interest in the Job Manager.
b. Next, scroll down to the table of results labeled "Molecular Orbitals." At the bottom of the table, look for an entry labeled "Electrostatic Potential." Click on the view icon ([image: ]) to view the potential mapped onto the surface of the molecule. It may take a few seconds for the map to appear.
c. When the image appears, you will see a representation of the surface of the molecule. To view the "ball-and-stick" structure of the molecule in addition to the surface, right-click on the surface and select "Transparent." You should now be able to identify which parts of the surface correspond to which atom. (Atom key: gray=carbon, white=hydrogen, red=oxygen, blue=nitrogen)
d. To be able to compare the potential surfaces, you must ensure that the color scale is the same for each (DO NOT SKIP THIS STEP!). Go to the "View" menu and select "Preferences". In the "Colors" tab, uncheck the "Autoscale range" box. Next, enter the following values in the "Mapped values (min/max)": -0.06 and 0.12 and click the "Apply" button.
e. Complete the data table for each of your models. Rotate your model so that you look at both sides and the edges.
f. Optional: If you want to save an image for later reference, go to the "File" menu and select "Save Image." You do not have to hand in any images, but you may find it useful to paste images into a document so that you can look at them side-by-side.
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EXPERIMENT 8 REPORT SHEET- PART I
	Melamine
(initial pH=2.1)
	
	Cyanuric Acid
(initial pH=2.1)
	
	Melamine/Cyanuric Acid Mixture
(initial pH=2.1)
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EXPERIMENT 8 REPORT SHEET- PART II

Electrostatic Potentials
	
	Color around N's in ring
	Potential
+ or -
	Color around N's not in ring
	Potential
+ or -
	Color around O's
	Potential
+ or -

	Melamine
low pH
	
	
	
	
	

	Melamine
high pH
	
	
	
	
	

	Cyanuric acid low pH
	
	
	
	
	

	Cyanuric acid high pH
	
	
	
	
	


Notes:
· The colors on the electrostatic potential map represent the following- red is a negative potential and blue is a positive potential; the colors in between run through the normal order of the spectrum. Thus, a yellow area would be a more negative potential than green and less negative than red and a green area would be more positive than yellow (and red), but less positive than blue.
[image: ]
· Although this is a simplification, you can think of an area of positive potential as an area of positive charge. Thus, since opposite charges attract, a positive potential area will be attracted to an area with a negative potential.


EXPERIMENT 8 QUESTIONS
Note: Use your data, computer modeling calculations, the lab manual introduction, and the article "Anatomy of a Pet Food Catastrophe" (Chemical and Engineering News, May 12, 2008) to help answer these questions. The article can be found online at: http://pubs.acs.org/cen/science/86/8619sci3.html.
1. What was the cause of death for animals affected by the pet food contamination event of 2007?



2. Is melamine soluble at all pH values tested in this experiment? Is cyanuric acid soluble? Is a mixture of melamine and cyanuric acid soluble? If any of these are not soluble, comment on the pH that produces a precipitate (an insoluble complex). Are your results consistent with the behavior of these molecules as described in the article?









3. Where in the body can you find a pH of
a. 2?

b. 5?

c. 7 (neutral)?

d. What is the current theory for why melamine cyanurate crystals do not form in blood?



4. What are the three main pieces of evidence that indicate melamine cyanurate is the entity responsible for the pet food contamination-related deaths?







5. A sample protein has the formula C45H71N15O13. Thus, the mass percent of nitrogen in this molecule is:


a. The formula for melamine is C3H6N6. What is the mass percent of nitrogen in melamine? (show your calculation)




b. Why is melamine so effective at raising the apparent protein content of a mixture (e.g., pet food or infant formula)?





6. Based on your results from Part II:
a. How does the electrostatic potential for melamine change when the pH changes?



b. How does the electrostatic potential for cyanuric acid change when the pH changes?



c. At the higher pH, which part of the melamine molecule would be attracted to the oxygen atoms in cyanuric acid? Which part of melamine would be attracted to the nitrogens in cyanuric acid?




d. Are the patterns of the potentials in the higher-pH forms of these molecules complementary?


e. Based on your results, does the hydrogen-bonding scheme presented in the introduction and in the Chemical and Engineering News article make sense? Explain your answer.



7. Consider the structures of melamine and cyanuric acid shown in the box below.
a. Label each chemical with its name.
b. Draw in the three hydrogen bonds that will form between the two molecules. Use a dotted line to indicate the hydrogen bond.
c. Label one of the N-H bonds with a + and a - to indicate the different charges on opposite ends of the polar bond (as is done for the O-H bonds in water in Figure 3).
d. Label the O=C bond with a + and a - to indicate the different charges on opposite ends of the polar bond.
[bookmark: _GoBack][image: ]


8. Please provide feedback on this lab activity. Did you like it, was it helpful for understanding hydrogen bonds, how would you change it, etc.
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